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This guide introduces you to ANCA Motion’s MotionBench software. The guide provides instructions for installing 
and getting started with MotionBench.

In this user guide, the following instructional icons are used:

The information contained in this guide was correct at the time of writing, but is subject to change. Please ensure 
you always refer to the version of the guide corresponding to the MotionBench version you are using.

Info

Tip

Note

Warning
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1 Related documents
Document Description

CHANGELOG.md History of product changes, located in the MotionBench 
application directory following installation

AMD Servo Drive - SoE Configuration Guide.pdf AMD servo drive user guide, included with ANCA Motion 
servo drives

Digital Servo Drive SoE Parameter Reference 
AMD5x.pdf

Firmware parameter reference, included with ANCA 
Motion firmware
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2 Terms and abbreviations
Action Bar A section of a page dedicated to controlling page operations

ANCA Australian Numerical Control and Automation

AMCore ANCA Motion's Motion Control Software

Bode Plot A magnitude and phase plot of the frequency response of a system

Chirp A signal in which the frequency increases with time

Configuration Panel A section of a page dedicated to configuration

CNC Computer Numerical Control

Display Area A section of a page dedicated to visual representation of data

EoE Ethernet over EtherCAT

EtherCAT   Ethernet for Control Automation Technology

IO Input/Output

RAM Random Access Memory

SoE Servo over EtherCAT

Standalone A type of network configuration that involves connecting the drive directly to a 
network adapter

Step A command signal in which the command instantly changes from one value to 
another

TDMS A file format optimized for saving measurement data to disk

UI User Interface
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3 What is MotionBench?
ANCA MotionBench is a Windows based tool that is designed to work with ANCA Motion’s range of EtherCAT servo 
drives.

MotionBench offers an easy to use graphical interface for configuring, monitoring, and diagnosing problems with 
AMD2000 and AMD5x servo drives.

• Communication via any EtherCAT master supporting EoE
• Real-time graphing of drive signals
• Guided and free-form workflows
• Powerful configuration and tuning features
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4 Get started

4.1 System requirements

Component Requirement

Platform • Laptop
• Desktop
• ANCA Motion CNC

Computer and processor 1 gigahertz (GHz) or faster x86- or x64-bit processor with SSE2 instruction set

Memory (RAM) 1 gigabyte (GB) RAM (minimum)

Hard disk 30 MB Free Disk Space (minimum)

Display 1280 x 960 Screen Resolution (recommended)

Operating system • Microsoft Windows XP SP2
• Microsoft Windows Vista / 7
• Microsoft Windows 8 / 8.1
• Microsoft Windows 10

.NET version 4.0

Supported (tested) 
network adapters

• Intel 82577LM Gigabit
• Broadcom NetXtream 57xx Gigabit
• Broadcom 57765-B0 PCI
• Marvell Yukon 88E8053 Gigabit
• ASIX AX88772A (USB2.0 to Ethernet dongle)
• Realtek RTL8139-810X

Minimum firmware version • 5.1.15 (AMT variant)
• 6.1.5 (AMD5x and AMD2000 variants)

Additional requirements 
and considerations

Some functionality may vary, based on the system configuration. Some features 
may require additional or advanced hardware or network connectivity.

The hard disk system requirement is intentionally larger than the actual disk space usage of the software.



Get started

11 2019-04-01 ANCA Motion

4.2 Install via Windows desktop
This section describes how to install MotionBench via the Windows desktop. If you are upgrading from a previous 
version of MotionBench, the steps are the same. Before installing MotionBench, make sure that your computer 
meets the system requirements.

1. Visit the MotionBench download link provided by ANCA Motion in any browser.
2. Click on the link to download the relevant version of the MotionBench installer. Depending on your 

connection speed, the download may take up to a few minutes.
3. If prompted, click "Run" or "Save".
4. If you have saved the installer, double-click the installer file to start the installation process.
5. After reading and agreeing to the license terms (available by clicking the "License Terms" link) click "Install".

4.2.1 Prepare the network connection
Connecting to a drive directly through an Ethernet port is known as the standalone configuration. To use this 
configuration, you will first need to change the network adapter settings by following the steps below.

1. Open Local Area Connection properties for the network adapter to be connected to the drive(s).

WARNING! Changing network settings may affect your computer’s network connection. If you are 
uncomfortable about making changes to your Ethernet adapter configuration, or do not have the required 
user permission levels, then please consult with your IT administrator.



Installing a second Ethernet adapter which is dedicated for use with the drive will prevent this possible 
limitation.


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2. Double-click "Internet Protocol Version 4 (TCP/IPv4)" to open the properties window for this protocol.
3. Select "Use the following IP address:" and set the IP address to 192.168.100.1 and the subnet mask to 

255.255.0.0.

4. Click "OK", and close the Local Area Connection properties window.
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5 General settings
The start behavior of MotionBench can be configured by clicking Tools → Options from the menu bar.

The following table list the available startup options:

Options Description

Launch Connection wizard at startup This option specifies whether MotionBench displays the 
connection wizard. If the option is not selected MotionBench 
starts with an empty window. A user can manually add a device 
by clicking Add on the Device menu.

Launch Quick Start wizard on startup This option specifies whether MotionBench displays a dialog to 
select a landing page on startup.

The controls shown in the "Protected Options" section are intended for internal use only and should not 
be used.


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6 Features
This section details some common workflows and procedures that are enabled by MotionBench.

6.1 Connect to a drive
MotionBench communicates with drives using EtherCAT via a standard Ethernet port.

A drive connection is established through the connection wizard. Opening MotionBench will open the connection 
wizard (by default) (see page 13).

6.1.1 Select a gateway
The first step in the wizard is to select a gateway. 

Communication with a drive is established through a gateway, which can either be a standard network adapter 
(standalone) or a conduit to an external control system like AMCore.

The tick box “Remember this gateway, and skip this step in the future.” will ensure that this gateway is 
used for future MotionBench session.


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If no gateway module is available for the current external control system, MotionBench can connect to a drive by 
manually specifying an IP address. To manually specify an IP address, select the "Advanced" link.

6.1.2 Select devices
For the next step in the wizard, you will need to select which devices to connect to. When a drive is physically 
connected, MotionBench will automatically detect it and show it in the device list.

AMCore must be running for the AMCore gateway to be detected.

If MotionBench is not using a gateway to connect to a drive, MotionBench will not be able to request 
control for the drive from the control system. In this case a user can only achieve partial control and some 
parameters will be marked as read only.


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The version of the firmware currently installed on the drive is indicated. If required, this can be updated using the 
“Update Device” button. If MotionBench cannot locate the firmware file (.amf) which matches the firmware 
currently installed on the device the following screen is shown to allow the user to select the matching firmware.

6.1.3 Finish up
Finally MotionBench shows the Quick Start menu. The Quick Start menu allows you to select a landing page. It can 
be disabled in MotionBench general settings (see page 13).

In a standalone configuration, the devices will not be detected unless the network adapter has the correct 
IPv4 properties set. To change the adapter properties, refer to prepare the network connection (see page 11).


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The following options are available:

Option Landing Page Description

Quick Start Motor Library Select a standard motor from the ANCA Motion 
range and get the motor turning with minimum 
effort.

Standard Configuration Overview Functional overview of the drive, where you can 
drill down into specific function modules.

Parameter Configuration Parameters Table where all variables in the drive profile can 
be accessed.

6.2 Monitor a connection
Once connected to a drive, MotionBench considers the drive either Online or Offline. A drive is considered online if 
MotionBench is able to communicate with it; otherwise, it is considered offline.

6.2.1 Connection status
The Connection Status screen can be accessed at any time via the following methods:

• Press F10.
• Click the "Connection Status" icon on the toolbar.
• Navigate to and click the menu entry: Device → Connection Status.
• Click on the connection information in the lower right corner of the status bar and select "Open Connection 

Status".

The Connection Status screen provides the following information:

• Device - The name of the device.
• Gateway - The name of the gateway through which the device is connected.
• IP Address - The IP (Internet Protocol) address of the device.
• Firmware Version - The current firmware version of the device.
• Activity - The number of bytes sent / received to / from the device.
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• Duration - The duration of time that the device has been Online.

6.2.2 Access drive parameters
Before any device parameter can be modified, MotionBench needs to negotiate access permission for the drive. 
This is done from the toolbar.

The following permission levels are available:

Level Description

Read-Only In Read-Only mode, MotionBench is allowed to display any device 
parameter. Parameter modification is not allowed. This mode is used to 
monitor a drive.



Features

19 2019-04-01 ANCA Motion

Level Description

Protected Write In Protected Write mode, MotionBench is allowed to display any 
parameter and modify parameters that do not interfere with a field-bus 
master controlling the drive.

Full Write In Full Write mode, MotionBench is allowed to display and modify any 
device parameter.

6.3 Move a motor
MotionBench allows a user to get a motor moving. This can be done in a number of ways.

6.3.1 Motor Library
The Motor Library page contains some basic functionality for getting a motor turning.

To do this:

1. Select your motor from the drop-down.
2. Click "Start".

a. In the dialog that follows, choose if you want some initial (no load) tuning set prior to enabling the 
motor.

3. Ensure safe operating conditions, then click "OK".
4. Click "Forward" or "Backward" to change the direction of movement.

6.3.2 Drive Controlled Moves
ANCA Motion drives can perform a sequence of up to 64 preset movements.

To configure the movements:

1. Go to the Drive Controlled Moves page.
2. Click "Load From Drive".
3. Modify the table of movements, then click "Save To Drive".
4. Enable the drive.
5. Click "Run" to begin the sequence of movements.

6.3.3 Drive Controlled Stroking
ANCA Motion drives can be configured to perform cyclic moves.

To do this:

1. Go to the Drive Controlled Stroking page.

For more information, refer to Motor Library (see page 54).

For more information, refer to Drive Controlled Moves (see page 46).
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2. Modify the stroking settings.
3. Enable the drive
4. Click "Run" to begin the movements.

6.3.4 Drive Controlled Homing
ANCA Motion drives can perform some movements to find a home-switch, setting it to zero (or "home").

To do this:

1. Go to the Drive Controlled Homing page.
2. Enable the drive.
3. Click "Run".

6.4 Tune a system
Most servo systems require some level of tuning (setting up the desired response of the system usually with the 
load attached). This can be done through several methods available within MotionBench.

6.4.1 Initial tuning
MotionBench has two methods for setting initial tuning.

6.4.1.1 Motor Library
After selecting a motor in the Motor Library page, clicking "Start" will recommend some initial tuning for the motor, 
and enable the drive. It will also start the motor turning, as it is intended to be used for a motor with no load 
attached.

6.4.1.2 Tuning pages
At times, you may not want to enable the drive immediately after setting the tuning.

In this case, you can set initial current and velocity tuning by going to the current and velocity tuning pages and 
clicking "Apply" in the suggested tuning calculator.

For more information, refer to Drive Controlled Stroking (see page 48).

For more information, refer to Drive Controlled Homing (see page 45).

For more information, refer to Motor Library (see page 54).

For more information, refer to Current Controller Tuning (see page 35) and Velocity Controller Tuning (see page 
62).


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6.4.2 Fine tuning
Once you have some initial tuning set, you can fine tune the system by analyzing the performance of the control 
loops.

6.4.2.1 Current loop
Fine tuning of the current loop can be performed as follows:

1. Go to the Current Controller Tuning page.
2. Ensure you have "Full Write" access.
3. Select your stimulus type and set the stimulus settings to be appropriate for your system.
4. Click "Start".
5. Click "Stimulate & Capture" or "Capture".
6. Analyze the results and make an appropriate change to the tuning parameters.
7. Click "Retune".
8. Repeat from step 5 until you are satisfied with your tuning performance.

6.4.2.2 Velocity loop
The velocity loop can be tuned in two different ways.

External motion controller

Fine tuning of the velocity loop using an external motion controller (i.e. AMCore) can be performed as follows:

1. Go to the Velocity Controller Tuning page.
2. Ensure you have "Protected Write" access.
3. Set your stimulus input amplitude to be appropriate for your system.
4. Click "Start".
5. Command the motor to move at a constant velocity greater than the stimulus input amplitude.
6. Click "Stimulate & Capture".
7. Analyze the results and make an appropriate change to the tuning parameters.
8. Click "Retune".
9. Repeat from step 5 until you are satisfied with your tuning performance.

Standalone

Fine tuning of the velocity loop in a standalone set up can be performed as follows:

1. Go to the Velocity Controller Tuning page.
2. Ensure you have "Full Write" access.
3. Select your stimulus type and set the stimulus settings to be appropriate for your system.
4. Enable the drive.
5. Click "Start".
6. Click "Stimulate & Capture" or "Capture".

For more information, refer to Current Controller Tuning (see page 35).

Only stimulus type "Chirp" is available when tuning via an external motion controller.
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7. Analyze the results and make an appropriate change to the tuning parameters.
8. Click "Retune".
9. Repeat from step 6 until you are satisfied with your tuning performance.

6.5 Configure drive settings

6.5.1 All parameters
There are two ways to set any firmware parameter.

6.5.1.1 Parameters page
On this page, parameters appear as a row in a table. With write access greater than "Read-Only", the parameters 
that can be modified will have a white background for their row.

To modify the value, simply click on the value column of the row, type your value, then press enter (or click 
somewhere else). The write is successful if the value doesn't change back to it's previous value.

6.5.1.2 Advanced mode
In this configuration mode, all firmware parameters are listed on the list, in the "Parameter Explorer".

To modify a parameter, drag the parameter into a "Calibration Window", then modify it's value column.

6.5.2 Digital inputs
Digital inputs may have their polarity changed. With DCSM firmware variant, the inputs can also be mapped to 
DCSM functions, i.e. enable, start drive controlled moves, etc.

To do this, go to the Digital IO page and click on "Digital Input Configuration". For each input, change the polarity 
by selecting "Active High" or "Active Low", or select a DCSM function from the drop-down.

For more information, refer to Velocity Controller Tuning (see page 62).

For more information, refer to Parameters (see page 57).

Advanced mode allows modification of any firmware parameter. Do not change anything unless you know 
what you are doing.



For more information, refer to Advanced mode (see page 70).

For more information, refer to the Digital Input Configuration (see page 45) section of Digital IO.
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6.5.3 Digital outputs
Digital outputs can have their polarity, safe state and command changed. Additionally, their state can be mapped 
to a parameter value.

To do this, go to the Digital IO page and click on "Digital Output Configuration". For each output:

• Change the polarity by selecting "Normal" or "Inverted".
• Change the safe state or command by selecting "High" or "Low".
• Set up a parameter controlled value by changing the "Control Method" to "Parameter", then click "Select".

6.5.4 Analog inputs
Analog inputs can be transformed by applying some functions to the actual input.

To do this, go to the Analog IO page and modify the parameter values in the configuration panel.

6.5.5 Analog outputs
Analog outputs can have their voltages directly commanded.

To do this, go to the Analog IO page and modify the parameter values in the "Analog Output" section of parameters.

6.5.6 Adjust scaling
The type of scaling (linear or rotary), as well as the scaling of the position, velocity, acceleration, and force can be 
modified.

To do this, go to the Scaling page, change the scaling parameters, then click "Apply Scaling".

6.6 Diagnose common drive issues
MotionBench provides various pages to monitor and to visualize feedback from the drive. These pages are provided 
to aid the engineer to commission a system or to diagnose faults in the feedback signals.

6.6.1 Control loops
Once a drive is enabled, you may want to check the behaviour of one of the control loops.

For more information, refer to the Digital Output Configuration (see page 42) section of Digital IO.

For more information, refer to Analog IO (see page 29).

For more information, refer to Analog IO (see page 29).

For more information, refer to Scaling (see page 59).
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To view these feedback signals:

1. Go to the Position, Current & Velocity page.
2. Click "Start".
3. Click the legend items to remove signals that you are not interested in.

6.6.2 Encoder feedback
If you are experiencing problems with encoder feedback, there are two pages you can visit to ensure your encoder 
is configured correctly.

6.6.2.1 Circle graph
This page will allow you to view the circle formed by the encoder data. If you can't see any feedback, you may have 
the wrong channel configured.

To compensate abnormalities in the circle:

1. Go to the Circle Graph page.
2. Click "Start".
3. Set the "Cos/Sin Offset" parameters such that the circle is centered.
4. Set the "Encoder Cos Phase Compensation" parameter such that the circle is aligned with the axes.
5. Set the "Cos/Sin Gain" parameters such that the circle vertical and horizontal amplitude are equal and do 

not exceed the minimum and maximum trip thresholds.
a. You can modify the minimum and maximum thresholds, but keep in mind that the maximum ADC 

values the compensated signals will have is ±32768.

6.6.2.2 State feedback
The State Feedback page allows you to change encoder configuration, set up a secondary encoder, view feedback 
directions, and more.

6.6.3 FOI
The only FOI algorithm currently supported in MotionBench is DQ alignment (DQA). To monitor the progress of DQA:

1. Go to the FOI-DQ Alignment Algorithm page.
2. Click "Start".
3. Enable the drive.
4. Check the electrical angle feedback follows the command (with an offset).

For more information, refer to Position, Current & Velocity (see page 58).

For more information, refer to Circle Graph (see page 31).

For more information, refer to State Feedback (see page 60).

For more information, refer to FOI-DQ Alignment Algorithm (see page 50).
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6.7 Log drive signals
In many MotionBench pages, some parameters are measured in real time and displayed in a graph. The parameters 
are relevant to the purpose of the page. However, you may want to monitor a parameter value that is not the 
subject of a standard page. To do this, there are two methods.

6.7.1 Data logger
ANCA Motion drives have an internal mechanism known as the Data Logger. This mechanism allows four parameter 
to be measured at up to the highest resolution (62.5 μs) for 2048 samples. MotionBench supports configuration of 
this mechanism in the Data Logger page.

6.7.2 Advanced mode
To set up live measurements for any drive parameter:

1. Switch to Advanced mode.
2. From the "Parameter Explorer", drag your desired parameter into the "Measurement List".
3. Change the "Event" column to the task rate you desire (lower number means faster sample rate).
4. Drag the measurement into the main window and select "Show in new Graph Window".
5. Press F5 to start measurements, and Shift+F5 to stop.

6.8 Save your drive configuration
There are two methods for saving drive configuration in MotionBench.

6.8.1 Single drive
When saving a single drive, there are two options available.

6.8.1.1 Save to file
To save modified parameters to a file:

1. Go to the Load/Save Parameters page.
2. Click "Save To File".
3. Select a file, or type the name of a file to create, then click "Save".

a. You can change the file format by choosing a format from the drop-down.
4. Enter any required information for the export to complete.

For more information, refer to Data Logger (see page 38).

For more information, refer to Advanced mode (see page 70).

For more information, refer to Load/Save Parameters (see page 52).
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6.8.1.2 Save to non-volatile memory
To save parameter values to non-volatile parameters (NVP):

1. Go to the Load/Save Parameters page.
2. Click "Save To Drive".
3. Move any parameters to be saved to the right list.
4. Click "Save".

6.8.2 Multiple drives
The CSV format save option from Load/Save Parameters is available as a multiple drive operation. Click File →
Export... to begin the operation.

For more information, refer to Load/Save Parameters (see page 52).

For more information, refer to Save all configuration (see page 67).
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7 Standard mode
The default mode for MotionBench is Standard mode.

In this mode, a navigation tree is added to the left of the window. This panel can be hidden by clicking View →
Navigation Tree in the menu bar, or by pressing F11.

Within the navigation tree, each connected drive is displayed with it's available pages as children. Clicking on a 
page will load the page in the remainder of the window. The pages available for a drive depends on the drive's 
firmware variant.

7.1 Page layout
Most pages have a Configuration Panel, Action Bar and a Display Area.
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7.1.1 Configuration Panel
The configuration panel section of a page is nested to the left of the window. It contains interface elements related 
to configuring the drive, or the experiment.

7.1.2 Action Bar
The action bar section of a page is nested to the bottom of the window. It contains buttons (or similar) for 
controlling page operation.

7.1.3 Display Area
The display area section of a page is the biggest section, taking up any remaining space in the window. Usually, it 
will contain a Plot, but it may contain any graphical UI.

7.1.3.1 Plot
A plot displays measured drive data as a graph. Each plot has the following controls available to control the graph:

An experiment is a procedure performed by MotionBench to assist with drive configuration. For example, 
obtaining a current chirp response (experiment) assists with current tuning (configuration).





Standard mode

29 2019-04-01 ANCA Motion

Control Description

Zoom in

Zoom out

Zooms in or out so that the entire graph is visible

 All Specify the zoom type whether it vertical, horizontal or all

 Show/Hide Points Toggles the visibility of data points on the graph

View: Followed by a list of views as buttons (e.g. Circle Plot). Clicking a 
button changes the active plot view. Each page implement it's own 
set of views

 Show/Hide Cursor Toggles the visibility of the data cursor on the graph

 Full/Normal View Collapses the configuration panel and the legend so the plot is 
expanded to the whole page

 Legend
Toggles the visibility of the parameter's data in the plot

7.2 Pages
This section contained detailed descriptions of each page that can appear in the navigation tree. For descriptions of 
workflows involving multiple (or single) pages, refer to section Features (see page 14).

7.2.1 Analog IO
The Analog IO page allows the user to monitor the analog voltage inputs, transform the input voltages, and directly 
control the voltage of the analog outputs.
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7.2.1.1 Configuration
A brief summary of each category of firmware parameters is described below. For a more detailed description of 
each of the parameters, please refer to the firmware parameter reference (see page 7).

Inputs

For each analog input, the effective input voltage can be transformed by applying the following functions:

Function Description

Offset This value will be subtracted from the actual input voltage

Dead Zone Threshold An actual input voltage that has magnitude lower than this value will be mapped to 0

Dead Zone Offset When the actual input voltage is above the threshold, this directional offset is added

Filter Coefficient Removes noise from the actual input voltage

Gain The actual input voltage will be multiplied by this value

Min/Max The effective input voltage will be saturated to remain between these limits

Outputs

These firmware parameters will directly command the voltage of corresponding analog output.
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Velocity Control

These firmware parameters allow modification of the mapping from analog input voltage to the input velocity 
command.

7.2.1.2 Display
The display shows the live transformed (effective) voltage for each analog input.

7.2.2 Circle Graph
This page allows a user to diagnose a fault with an analog encoder. The image below shows the circle plot for an 
analog encoder.

7.2.2.1 Configuration
A brief summary of each category of firmware parameters is described below. For a more detailed description of 
each of the parameters, please refer to the firmware parameter reference (see page 7).

Category Description

Encoder Changes the encoder feedback signals that are display in the plot 
window
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Category Description

Encoder Type Verify that the correct encoder type firmware parameter is set: the 
connected channel should display Incremental

Adjustment Parameters Allows imperfections in the encoder feedback signal to be 
manually adjusted

Limits Defines the minimum and maximum magnitude encoder signal 
before a drive error is thrown

7.2.2.2 Actions
For this page, the following actions can be performed.

Action Description

Start Begins the live plotting of the encoder feedback signals

Save Saves the plotted data to a file

7.2.2.3 Display
The display is a plot containing two views.

Circle Plot

The circle plot displays live encoder data in the form of a scatter graph. The sampled points will form a circle when 
the encoder is rotated, hence the name.

The orange and red circle shows the minimum and maximum amplitude before a drive error is thrown; the green 
signal must always lie between the two circles for normal operation.

Time Domain

The time domain plot is split into two graphs.
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The upper graph shows the same data as the purple signal in the circle plot, but in time domain.

The lower graph shows the squared amplitude of the two signals from the circle plot, in time domain. With properly 
set adjustment parameters, the green signal in this plot should be almost completely constant.

7.2.3 Current & Thermal Protection
This page allows configuration of firmware parameters related to protecting the drive from damaging the motor.
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7.2.3.1 Configuration
There are two configuration sections: Limits and Overload Protection.

Limits

There are three types of parameters in this section.

Type Description

Peak current limit Saturate the current command to the lower of the three values

Current limiting Indirectly limit the current command

Temperature limit Subsystem of the drive that cause a shutdown when the 
temperature of different components gets too high

Overload Protection

There are two types of parameters configured by this section.

Type Description

Short term Subsystem which throws an error when the current is too high for a short period of time

Long term Subsystem which throws an error when the current is too high for a long period of time
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The short term parameters have accompanying suggested values: click Apply to set these values.

7.2.3.2 Actions & Display
Reserved for future development.

7.2.4 Current Controller Tuning
This page allows the user to tune the current loop of the drive. By obtaining chirp or step responses, you can 
determine an appropriate change to the tuning parameters, then see the effect of your changes.

7.2.4.1 Configuration
In the configuration panel, there are two types of configuration:

The suggested values are calculated such that a peak current will cause an error after the number of 
seconds passed equals the overload duration.



The physical parameters affecting current loop tuning are primarily the resistance and inductance of the 
winding circuits. These parameters are usually fixed for any particular motor, thus the current loop tuning 
is determined primarily by the motor.


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Type Description

Stimulus Allows selection of the the stimulus type (chirp or step), as well as modify the 
amplitude and offset of the stimulus.

Tuning Allows direct modification of the properties that define the current loops. Also 
suggests (and optionally sets) initial tuning, assuming no load is attached to 
the motor.

7.2.4.2 Actions
The following actions are used to control the tuning process.

Action Description

Retune Retune the drive.

Start (Chirp) Begin the experiment by starting live measurements and drive 
controlled moves.

Stimulate & Capture (Chirp) Set up data logger, wait for trigger, and display the results.

Start (Step) Begin the experiment by starting live measurements and drive 
controlled stroking.

Capture (Step) Set up data logger, wait for trigger, and display the results.

Save Saves the captured data for offline analysis.

7.2.4.3 Display
The display area contains a plot with the following views:

Live

This plot view shows the live measured data of the current command and feedback signals. The measurements are 
shown in a time domain graph with a history of 10 seconds.

Captured

This plot view shows the data that was captured during stimulation. It is captured by the drive data logger, and is 
plotted in the time domain. A sample chirp capture is shown below.

There are two current loops in the drive: D-axis and Q-axis. Under normal circumstances, these loops 
should be the same. For more information, refer to the servo drive user manual.


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Captured (Closed Loop Bode)

This plot shows the captured chirp data in the frequency domain. It is split into two graphs, containing the 
magnitudes and phases. These are calculated based on the response relative to the stimulus. This is known as 
a closed loop Bode plot.

Captured (Open Loop Bode)

This plot also shows captured chirp data in the frequency domain, split into magnitude and phases. In this case, the 
magnitudes and phases are calculated based on the response relative to the following error. This is known as an 
open loop Bode plot. 
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Closed Loop Bode Open Loop Bode

Users can switch the X-Axis scale type between Logarithmic or Linear via this button  . This is 
only available on the Captured (Closed/Open Loop Bode).

7.2.5 Data Logger
This page allows you to setup the drive to sample up to four different parameters from the drive, each with 2048 
data points.

7.2.5.1 Configuration
Three different triggers types are available to control under what conditions the data log will trigger.
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• Immediate
• Parameter Controlled
• Class 1 Diagnostic (C1D) Fault

Immediate Trigger

If immediate is selected and the Run button is clicked MotionBench instructs the drive to immediately start 
sampling the parameters and upon completion displays the captured data.

Parameter Description

Data Logger Sample Period Factor The data log is sampled at the rate of the motor control update, 
62.5us. Sample Period Factor provides the ability to skip integer 
multiples of 62.5us.

Parameter Controlled Trigger
If Parameter Controlled Trigger is selected and the Run button is clicked MotionBench instructs the drive to arm the 
drive data logger. The drive will use the selected trigger parameter to determine when to begin finalizing data 
logging. When MotionBench detects that the data log has been completed it will automatically display the results.
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Parameter Description

Trigger Parameter Any parameter within the profile can be selected as the trigger. If the 
selected parameter is an array the Index field specified the array 
index of the parameter.

Data Logger Trigger Mask This mask is applied to the value of the trigger parameter for 
selecting the bits to trigger off. Setting this parameter to zero 
disables the mask (Equivalent to a mask of 0xFFFF FFFF).
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Parameter Description

Data Logger Trigger Value This is the value that the trigger parameter is compared to (with the 
trigger mask applied if applicable) for the data logger to trigger its 
completion.

Data Logger Sample Period Factor The data log is sampled at the rate of the current control update, 
62.5us. Sample Period Factor provides the ability to skip integer 
multiples of 62.5us.

Data Logger Pre-Trigger Samples Specify the number of pre-trigger samples to log. The Pre-Trigger 
Samples parameter informs the drive of how many samples to keep 
prior to the trigger event. For instance if this value is set to 500 the 
buffers returned on completion of the data log will include 500 
samples taken immediately before the trigger event occurred and 
1548 after for a total of 2048 data points.

Comparison Type Defines how the Data Logger Trigger Value is compared with the 
trigger parameter.

Class 1 Diagnostic Fault Trigger

If Class 1 Diagnostic (C1D) Fault trigger is selected the drive will begin finalizing data logging when a critical fault 
that disables the drive is detected. When MotionBench detects that the data log has been completed it will 
automatically display the results.

7.2.5.2 Actions
On this page, the following actions are available.

Action Description

Start Start the data logger

Plot Plots the contents stored in the data buffers. It is only available/clickable if 
the data buffers are not empty

Save Saves the plotted data to a file (.dat)

Advanced Allows the user to import or export a configuration

7.2.5.3 Display
The display is a plot containing a time domain graph of the drive data logger data.
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7.2.6 Digital IO
The Digital IO page allows the user to specify how the drive is controlling the digital outputs, and inputs.

7.2.6.1 Configuration
There are two modes of configuration available: Digital Output Configuration and Digital Input Configuration.

Digital Output Configuration

If the selected "Control Method" is "Manual" mode, a user can use the "Command" button to toggle the physical 
output to be high or low.

In "Parameter" mode, any drive parameter can be selected to trigger a digital output.

Pressing the "Select" button brings up the following dialog to specify the parameter from which the value will be 
obtained for constructing the digital output.
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The "Safe State Mask" specifies the default user-defined digital output safe state. This is the value used when the 
drive enters the EtherCAT state SAFEOP as a result of abnormal conditions. The "Invert Mask" specifies whether a 
selected bit of the input value needs to be inverted before the digital output is constructed. The "Mask" is used to 
mask out the required bits from the parameters value. The simulation section of the dialog allows a user to test out 
the required settings before applying the parameter.

The simulation is enabled or disabled by pressing the button.

Example:
Let’s assume the "Master Control Word" parameter has been selected to control a digital output. When the drive is 
enabled the user also wants to activate a digital output. Bit 14 of the master control word is drive enable. Any other 
bit of the control word should be ignored. The following image shows how the mask can be configured to only 
trigger when bit 14 of the master control word is set. When you toggle test input 14 the output should follow. 
Toggling any other bit in the test input should not affect the state of the output.
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To define the safe state for the digital output specify the bit in the safe state mask that will set the output state. See 
the image below.
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Digital Input Configuration

The user can select from the drop-down box a digital input to trigger one of the drive controlled functions. The 
"Polarity" control indicates whether the drives need to invert the value read from the digital inputs. Changes on this 
page immediately updates the drive.

Display

Live update and display of digital inputs are reflected here. If the digital input is on, it displays the bit in a light blue 
colored bar. If it is off, it will be a light grey colored bar.

7.2.7 Drive Controlled Homing
The Drive Controlled Homing page allows the user to configure the homing routine of the drive. The homing routine 
can be executed by the drive in standalone operation (i.e. without an external control unit).
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7.2.7.1 Configuration
The configuration section contains two collapsible panels. The "Measurement" panel shows a live display of the 
drive controlled homing state. The "Configuration" panel contains parameters that alter operation of the homing 
algorithm.

Any changes to the drives parameters takes immediate effect. Please refer to the Parameter Reference (see page 7) for 
a detailed description of the parameters that configure Drive Controlled Homing.

7.2.7.2 Actions
Only a single action is available for this page:

Action Description

Start Triggers the drives homing routine and starts monitoring the feedback signals.

7.2.7.3 Display
The display is a graph of position feedback versus time. It allows observation of the homing routine in progress.

7.2.8 Drive Controlled Moves
The Drive Controlled Moves screen in MotionBench allows you to easily enter and manipulate moves in a tabular 
format.
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In the table, you can enter specific moves and edit moves. The table you build remains in MotionBench until you 
load the moves into the drive. Once the moves are loaded, you can execute the moves from a specified Start Index
and see the current move highlighted live.

7.2.8.1 Actions
The following actions are available on this page:

Action Description

Save to Drive Saves the modified parameters in the table to the drive.

Load from Drive Loads drive controlled moves table with current values from the drive. 
This action overwrites the current content of the table.

Save to File Saves the parameter information in the table to a file.

Load from File Loads and overrides the drive controlled moves table with values from 
selected file.

Run/Stop Execute the moves from a specified Start Index.
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7.2.8.2 Display
The data table includes the following editable fields:

Column Description

Move start First segment of drive controlled move to be executed.

Following Move Next move for a drive controlled move sequence.

Position Drive controlled move segment Target Position.

Start Acceleration Start acceleration limit for move segment.

Speed Velocity limit for move segment.

End Acceleration End acceleration limit for move segment.

Move Transition Move transition type for move segment. Changing the move transition 
type is only possible if the previous and next move segment don't 
force a change in direction.

Dwell Delay Time to wait before starting next move. Changing the delay time 
is only available if the move transition type is set to Blend_off.

7.2.9 Drive Controlled Stroking
The Drive Controlled Stroking page allows the user to configure the drive to perform cyclic moves. On this page the 
user can make modification to the drive parameters and observe the various feedback from the drive.
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7.2.9.1 Configurations
The configuration section contains two collapsible panels. The "Measurement" panel shows a live display of the 
drive controlled stroking state, stroke count, edge state and velocity feedback. The "Configuration" panel contains 
parameters that alter behaviour of the stroking algorithm.

Any changes to the drives parameters takes immediate effect. Please refer to the Parameter Reference (see page 7) for 
a detailed description of the parameters that configure Drive Controlled Stroking.

7.2.9.2 Actions
Only a single action is available for this page:

Action Description

Start Triggers the drive to perform the stroking moves and starts monitoring the feedback signals.

7.2.9.3 Display
The display is a plot containing a time domain graph of the estimated joint position. This allows observation of the 
cyclic moves in progress.
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7.2.10 FOI-DQ Alignment Algorithm
This page allows the user to diagnosis issues with the Field Orientation initialization (FOI) algorithm known as DQ 
Alignment (DQA).

 This algorithm is capable of detecting a large number of configuration / hardware based issues, specifically:

• incorrect motor poles configured
• incorrect motor phase sequence
• incorrect motor encoder line count configured
• incorrect motor encoder polarity configured
• the configured alignment current is too low to drive the motor
• motor/axis is jammed
• poorly tuned current loop
• DC bus voltage too low
• motor armature cable is disconnected
• STO is active

7.2.10.1 Actions
Only a single action is available for this page:

Action Description

Start Starts monitoring the signals.
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7.2.10.2 Display
The display is a plot split into two graphs.

The upper graph shows the commanded electrical angle against the measured electrical angle.

The lower graph shows the commanded current against the measured current.

7.2.11 Height Following
It allows users to configure height following, which maintains a constant cutting height even if the sheet is not 
flat. On standalone mode, users can set parameters related to height following and able to control the device’s 
movements. On the CNC, the users are able to monitor height following states via the display area.

Configuration
In the configuration panel, it contains parameters the enable the users to set sensor properties, locations of 
important axis heights, and better performance properties.

7.2.11.1 Actions

Action Description

Start Enables the position loop and starts plotting.
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Action Description

Enable Enables the height following firmware algorithm.

Retract Retracts the axis to a predefined height.

Freeze Pauses the approach at it's current height.

Expire Tells the drive that it's height estimate is invalid, causing a movement to enter 
the sensor range to re-estimate the sheet height.

Save Save the plotted data into a file (.dat).

7.2.11.2 Display
A plot that graphs the desired, estimated and sensed heights of the axis. It also shows the main state of height 
following.

7.2.12 Load/Save Parameters
MotionBench typically works with volatile parameters in the drive. In order to persist any configuration of the drive 
MotionBench offers a number of options for saving and restoring your configuration via the Load/Save Parameters
screen.

To copy a configuration from one drive to another, click the Save to File button on the first drive and then use the 
Restore from File on the second drive. If you wish the second drive to keep these new parameters after the drive is 
turned off, then you can save the parameters to the non-volatile memory with Save to Drive.
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7.2.12.1 Actions
The following actions are available on Load/Save Parameter page:

Action Description

Save To File Reads all drive parameters and saves those that differ from the 
firmware defaults to file

Restore From File Writes the values of parameters in the selected file to the drive

Save To Drive Saves a selection of parameters into the non-volatile memory of the 
drive. Each time the drive powers on, it will start with these saved 
parameters.

The drive has limited memory to store parameters. A user can specify 
in the following dialog which parameters can be retained on drive 
restart.
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Action Description

Restore From Drive Overwrites current drive parameter values with those of parameters 
stored in the drive's non-volatile memory

Reset To Defaults Returns all drive parameters back to their default values. Any changes 
you have made are lost

7.2.13 Motor Library
The Motor Configuration page is used to set up or confirm the parameters associated with the motor that is 
connected to the drive.
The Motor Configuration screen includes the following functionality:

• ANCA Motion motors which are compatible with the drive are available in the motor library.
• Custom motor parameter sets can be created and added to the motor library if the connected motor is not 

listed.
• All motors can be imported and exported from the motor library.
• Drive motor parameters are automatically detected and imported to the library if necessary.
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Configuration
The configuration panel is split into two sections: the motor library and the parameters.

7.2.13.1 Motor library
The motor library section contains a drop-down list of standard motors (ANCA Motion motors) and custom motors. 
Selecting a motor will configure the drive parameters for the selected motor.

It also allows you to create a new motor or manage the motor library.

Manage the motor library

Clicking the "motor library" link (or selecting it from the drop-down) will bring up the motor library dialog, shown 
below.

The dialog allows you to:

• Create a new (custom) motor.
• Delete a custom motor.
• Rename a custom motor.
• Import a motor.
• Export a custom motor.

Create a new motor

Clicking the "new motor" link (or the "New..." button in the motor library dialog) brings up the new motor dialog, 
shown below.



MotionBench User Guide

56 2019-04-01 ANCA Motion

The dialog allows you to:

• Change the name of the new custom motor.
• Choose initial values for the new custom motor.

• None: All initial values are 0.
• Current: Copy initial values from the currently selected motor.
• Copy from: Select a motor from the library; the initial values will be copied from it.

7.2.13.2 Parameters
The parameters section contains the configurable parameters related to the motor and the encoder.

7.2.13.3 Actions
The following actions are available to test and confirm correct configuration of the drive.

Action Description

Save Saves the current motor parameters to the drive. This button will be enabled when any of the 
motor parameters have changed.

Start Allow the user to start motor movements to confirm correct motor parameters.

Forward / 
Backward

Controls the direction of the movement.

Clicking "Start" will display a dialog allowing you to first set some recommended tuning (see below). The tuning 
assumes no load is attached to the motor.
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7.2.13.4 Display
The display area contains the rendered image of the actual motor if it is a standard ANCA Motion motor. For custom 
motors, the image shown below will be displayed.

7.2.14 Parameters
This page displays a list of the current values of all the parameters that the drive supports and is continually 
updated.

Parameter values can be changed as necessary. Any changes to the parameter take effect immediately.

Parameters with a grey background are read-only and cannot be modified. ANCA Motion drives have a vast amount 
of configuration parameters that can be used to optimize the drive for a particular application. To help find a 
specific parameter this page provides a filter function that allows the user to search and filter for any information 
listed in the table. The table rows can be sorted by clicking any of the column headers.
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7.2.14.1 Actions
A search "Filter" text box allows the users to type in a text that filters the parameters being displayed. The search 
filter applies across all the columns. The users are then able to modify the values of the parameters by directly 
clicking and typing in the new value in the "Value" column.

7.2.15 Position, Current & Velocity
This page allows a user to investigate whether one of the control loops is experiencing saturation or is not 
performing normally.
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7.2.15.1 Actions

Action Description

Start Starts plotting the control loops

7.2.15.2 Display
A time domain graph that shows the feedback of the control loops.

7.2.16 Scaling
On the scaling configuration page, a user can configure the drive to convert data into units that are more 
meaningful to the application.
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7.2.16.1 Configuration
 For more information about the scaling related parameters refer to the drive firmware parameter reference (see page 
7) document.

7.2.16.2 Actions
Modifying the scaling parameters does not take immediate effect. To instruct the drive to apply the new scaling 
parameters the user needs to select the "Apply Scaling" button.

7.2.17 State Feedback
This page allows the user to configure the parameters related to mechanical configuration (gear-box ratio, ball 
screw feed constant, etc.), and the encoder configuration. It also gives real-time feedback of the measured position 
and velocity of the axis.
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7.2.17.1 Configuration
A brief summary of each category of firmware parameters is described below. For a more detailed description of 
each of the parameters, please refer to the drive firmware parameter reference (see page 7).

Category Description

Encoder Type Allows the user to select the encoder type for each channel.

Motor Encoder Settings for the motor encoder.

External Encoder Settings for an external encoder.

Gear Ratio The input and output revolutions and the feed constant.

Filter The motor velocity filters.

7.2.17.2 Display
The display shows an image indicating the direction the motor is moving. For rotary motors, the display is shown 
above. The linear motors, the display is shown below.
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7.2.18 Velocity Controller Tuning
This page allows the user to perform experiments to capture data that can be used to tune the velocity loop 
controller and torque reference filters. The page supports both chirp and step stimulus signals. The page gives 
direct access to the stimulus configuration parameters, the tuning parameters and the retune procedure 
command. With the step stimulus, tuning can be conducted in real-time.

7.2.18.1 Configuration
In the configuration panel, there are two types of configuration:

Type Description

Stimulus Allows selection of the the stimulus type (chirp or step), as well as modify the 
amplitude and offset of the stimulus.
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Type Description

Tuning Allows direct modification of the properties that define the velocity loops and 
the torque filters. Also suggests (and optionally sets) initial tuning, assuming no 
load is attached to the motor.

7.2.18.2 Actions
The elements in the next table are used to control the tuning process.

Action Description

Retune Retune the drive.

Start (Chirp) Begin the experiment by starting live measurements and drive 
controlled moves.

Stimulate & Capture (Chirp) Set up data logger, wait for trigger, and display the results.

Start (Step) Begin the experiment by starting live measurements and drive 
controlled stroking.

Capture (Step) Set up data logger, wait for trigger, and display the results.

Save Saves the captured data for offline analysis.

7.2.18.3 Display
The display area contains a plot with the following views:

Live

This plot view shows the live measured data of the current command and feedback signals. The measurements are 
shown in a time domain graph with a history of 10 seconds.

The image below shows the time domain data from a velocity step stimulus signal, the response and the motor 
current command updating in real-time. With the data updating in real-time, the user can immediately see the 
result of changes to the tuning parameters.
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Captured

This plot view shows the data that was captured during stimulation. It is captured by the drive data logger, and is 
plotted in the time domain. A sample chirp capture is shown below.
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Figure 1

Captured (Closed Loop Bode)

This plot shows the captured chirp data in the frequency domain. It is split into two graphs, containing the 
magnitudes and phases. These are calculated based on the response relative to the stimulus. This is known as a 
closed loop Bode plot.

Captured (Open Loop Bode)

This plot also shows captured chirp data in the frequency domain, split into magnitude and phases. In this case, the 
magnitudes and phases are calculated based on the response relative to the following error. This is known as an 
open loop Bode plot.

The table below shows the data from Figure 1 converted into a Bode plot (Open or Closed loop frequency 
response). From this data the user can measure velocity loop bandwidth and identify mechanical resonance. 
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Closed Loop Bode Open Loop Bode

Users can switch the X-Axis scale type between Logarithmic or Linear via this button  . This is 
only available on the Captured (Closed/Open Loop Bode).

7.3 Guided configuration
MotionBench provides various configuration modes to configure a drive for a specific application. You can select a 
configuration mode by right clicking a device node in the device tree and then selecting one of the available modes. 
Once a mode has been selected MotionBench applies a set of mode specific parameters to preconfigure the drive 
and presents configuration pages relevant for the selected mode

To return to the default view listing all available configuration pages right click a device and select Default. When 
MotionBench returns to the default view it does not modify any parameters and leaves the drive in the current 
modes of operation.
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7.3.1 Modes
The following modes are available:

Mode Description

Drive Controlled Moves Guides the user to set up a drive to automatically execute a 
sequence of pre-programmed moves.

Drive Controlled Stroking Guides the user to set up a drive to automatically execute cyclic 
moves.

NC Velocity Guides the user to set up a drive to receive motion commands via a 
higher level controller, such as a CNC.

Gantry Tuning Guides the user to set up a pair of drives in a gantry axis to receive 
motion commands via a higher level controller, such as a CNC.

7.4 Save all configuration
Two menu items allow the configuration of multiple devices to be exported and imported in a single operation.
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7.4.1 Export multiple devices
Click File → Export... to begin the multiple device export operation. This operation performs the Save To File (CSV) 
operation from the Load/Save Parameters page for multiple drives in one operation.

 Additionally, you can optionally execute a command after the export completes to merge the exported CSV to your 
own format.

The advanced options allows you to select which devices are exported, as well as change the device configuration 
name.

7.4.2 Import multiple devices
Click File → Import... to begin the multiple device import operations. This operation performs the Load From File 
(CSV) operation from the Load/Save Parameters page for multiple devices in one operation.

 Additionally, you can optionally execute a command before the import begins to merge from your own format to 
the CSV file to be imported.

The advanced options allows you to modify which device configuration is imported for each device. By default, a 
device will be matched to a device configuration with the same name.

7.4.3 Customize database integration
Migration from the CSV format to your own custom database format can be achieve using the "post-export 
command line" and "pre-import command line" text boxes.

An exported device will be referred to as a device configuration. It is a text representation of all of the 
non-default firmware parameters.


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The text entered into one of these text boxes will be ran in cmd after the export completes or before the import 
starts.

You will need to write two scripts (or executables) that convert to and from your format. Then, modify the 
command line text boxes in the import and export dialogs such that your scripts are run before the import and after 
the export.

7.5 Faults and warnings
When a fault occurs, the drives output stage is switched off (motor loses all torque), and the drive state becomes 
Disabled.

The status bar (highlighted in the image below in red) along the bottom of the MotionBench application window 
displays the associated error number and message, as well as the state of the drive.

Most faults can be cleared without power cycling the drive. Once the fault cause is remedied, you can clear the fault 
using the "Reset Error" button in the MotionBench toolbar (highlighted in the image above in green). Note that if 
the drive was Enabled when the fault occurred, the "Enable" button in the MotionBench toolbar remains primed. 
Clicking "Reset Error" in this scenario will return the drive to Enabled.

Two sample scripts are included by default that migrate to and from an AMCore parameter database (.db)
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8 Advanced mode
Advance mode is a special mode in MotionBench that allows access to all parameters and signals in the drive.

This mode is selected by clicking Advanced in the Device-Configuration Mode menu. In advanced mode you have 
the ability to graph and modify any parameter by dragging it into the workspace. To add a parameter select the 
parameter in the parameter Explorer tree and drag the parameter while holding the right mouse button. When you 
release the mouse button in the workspace you have the option to display the parameter in a measurement or a 
calibration window.

If the measurement window is selected the parameter is first added to the measurement list. The measurement list 
is a container for parameters that need to be streamed from the drive. Any parameter in the measurement list can 
be dragged into the workspace and displayed in a numeric or graph window. Parameter in the measurement list 
are read-only and updated when the measurement is started. To start measurements select Start in the 
Measurements menu or press F5. To stop measurements select Stop from the Measurements menu or press 
Shift+F5.

Parameters displayed in a calibration window can be modified. Any modification to a parameter in the calibration 
window takes immediate effect. The new value is transferred to the drive when the current Value edit field loses 
focus.

The buffers of the current measurement list can be saved in TDMS file format by clicking Save Buffers in the 
Measurements menu. TDMS is a structured file format by National Instruments that can be loaded by LabVIEW, 
Excel or any other application that supports the TDMS format.
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9 Troubleshoot
This chapter provides troubleshooting techniques to assist if you are experiencing problems connecting to a drive.

1. Configure the network adapter (refer to Prepare the network connection (see page 11)). To ensure the network 
adapter is functional try pinging the network address you specified in the previous step.
To ping the network adapter open a new command window by pressing Window-Key + R and type "cmd".
In the command window type "ping 192.168.100.1".

2. Confirm that the network adapter connected to the drive is enabled. You can check the status of the 
network adapter by pressing Window-Key + R and type ncpa.cpl. Check in the network connection window if 
the status of the adapter is set to "Enabled". If the network adapter is disabled enable the adapter. Right 
click on the adapter in the list and select "Enable".
If the adapter is in an error state which is usually indicated by a red cross on the network icon, try to disable 
and then re-enable the network adapter. Right click on the adapter in the list and select Disable and then 
Enable to re-enable the adapter.
By default Windows will disable a network device to save power if it is not in use. If you have just connected 
the drive to the computer it can take a couple seconds for windows to recognize that the network adapter is 
now active. If you have to frequently connect and disconnect drives it is recommended to disable power 
saving on the network adapter. Please consult the Microsoft documentation on how to adjust the power 
management features. 

If after reading the User Manual you still require assistance for installation, training or other customer support 
issues, please contact the closest ANCA Motion Customer Service Office in your area for details.
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10 Contact Information

10.1 General Enquires
https://motion.anca.com/Contact

10.2 ANCA Motion Pty. Ltd.
1 Bessemer Road,
Bayswater North,
VIC 3153,
Australia

Telephone:        +61 3 9751 8900

Fax:                   +61 3 9751 8901

Email: sales.au@ancamotion.com1

10.3 ANCA Motion Taiwan
4F, No. 63, Jingke Central Road, Nantun District,
Taichung City 40852,
Taiwan

Telephone:        +886 4 2359 0082

Fax:                   +886 4 2359 0067

Email: sales.tw@ancamotion.com2

10.4 ANCA Motion (Tianjin) Co., Ltd.
No. 102, Building F1,
XEDA Emerging Industrial Park,
Xiqing Economic-technological Development Area,
Tianjin, P.R.China

Telephone:        +86 22 5965 3760

Fax:                   +86 22 5965 3761

Email: sales.cn@ancamotion.com3

https://motion.anca.com/Contact
mailto:sales.au@ancamotion.com
mailto:sales.au@ancamotion.com
mailto:sales.tw@ancamotion.com
mailto:sales.tw@ancamotion.com
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